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Chapter 0 Introduction: Filling Your Design Pockets

The Designing Effective Logos: Learn by Video series covers a lot of territory: creativity, sourc-

ing inspiration, learning to make visual connections concisely and accurately, resources for 

managing your business and displaying your work, creating final documents for the client’s 

use, and finally, the ultimate purpose of designing logos that are beautiful for the audience 

to experience, fun for you to create, and effective ambassadors for your client’s business 

growth. In my mind, logo design is more than just “design.” It’s very satisfying to create a 

successful logo. It constantly teaches you about the most intimate and hidden relationships, 

and you come to understand the world in a more connected way. 

As you move through the principles and ideas presented in the series, take notes. They 

can be doodles, sketches, words, thoughts. It doesn’t matter how you absorb information 

for later use—however you do it is perfect! The note taking process is simple. Whenever 

you start a new video, pull out your sketchbook and a pencil or pen, and have them at the 

ready. When something strikes you as interesting or pertinent, jot it down or sketch it. The 

concepts you note are the ones that relate to you in the most meaningful ways. I want you 

to note them because they—or some iteration of them—will become valuable fodder for 

your ultimate and (hopefully!) very personal logo. Take the time periodically to find ways 

to integrate these ideas into your own logo. When inspiration strikes, grab it! But even if 

it doesn’t, clear some time for your creativity with the intention of coming up with some 

good logo concepts of your own (see the video in Chapter 3, “Design Flow” for more on this 

technique). Periodically sit down and focus on what you can create with the original con-

nection you made.

As you move through the series exploring ways in which to approach logo design, 

experiment with your own logo ideas using the various concepts. You can experiment 

with the traditional logo style of symbol, logotypes, and visual metaphors, as well as 

explore the shapes, patterns, and forms of nature—and even add things like emptiness 

as an element to your design. If you’re diligent in this process, I promise you will have an 

interesting assortment of concepts to filter through and consider for your own ultimate logo 

design. As an added benefit, I also promise this process will teach you a lot about yourself. 

In learning about yourself, you learn more about human nature. This practice inherently 

makes you a better logo designer. 
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Finally, the ultimate benefit of narrowing your concepts to a final logo design prepares you 

to use your identity in the world to support your business, while the experience gives you a 

fundamental understanding of how to create a logo that will make your first logo project a 

success for your client and for you. 

You came to this series because you are a special-needs designer: You are one who needs to 

know and share what you learn. I welcome and commend your curiosity, your persistence, 

and your desire to serve the greater good of creating design that truly delivers value to its 

audience.

Thank you for taking part!

P.S. You can actively engage the Designing Effective Logos community by joining the 

Facebook group: https://www.facebook.com/groups/1457979254455888. Share your work, 

comments, opinions, and questions with those who love logo design just like you do. 
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Chapter 1 Exercise: Sensual Observation 

Use this exercise to note, explore, and enhance your experience of processing sensual informa-

tion. Being able to perceive everyday experiences with more depth and thoughtfulness will 

enhance your ability to create observant design.

Plan to take multiple walks over a period of days, taking with you your notebook, colored 

pencils, paints, and pen and/or pencils (use the medium you prefer but bring along supplies 

that you can integrate color with). It’s handy to use a backpack or other hands-free item for 

storage; this lets you easily collect found objects and store them for later. 

During each walk, choose a particular sense you would like to explore—sight, touch, taste, 

hearing, or smell—and intentionally focus on just this one particular sense. It’s optimal to 

do one sense/one walk per consecutive day. Your thoughts and external events will tend to 

make your mind wander, and your other senses will come into play. If you’re working with 

the sense of hearing, for example, you’ll be using sight, too. Continually bring your focus 

back to your chosen sense and remove the distractions you can (eliminate your phone, 

Internet, or other outside influences you have control over). Listen beyond the louder 

noises: If you’re in a city park, listen to the soft sounds close to you instead of the loud 

sounds that carry from a distance. Listen for the subtlety in natural sounds. Find alignments 

between sense and design. Silence is like white space. Reverse your normal tendency to 

hear (or sense) the overt. Find sound within silence. What does it sound like? Is it abstract or 

does it have a shape? Does it remind you of something you have experienced before? Take 

notes on what you become aware of. 

1.	 Take a moment to stop and sit. Reviewing your notes while still paying attention to the 

selected sense, write about what you experienced and how it made you feel. You can 

use singular words, a poem, a haiku, or a few sentences. Stay present with the sense so 

you can capture it as accurately as possible. 

2.	 Draw what you hear (or feel, see, taste, or smell). If you don’t know what it looks like, 

draw what you imagine it to be. This can be abstract and colorful. Integrate it with your 

writing. Remember to give character to your lettering as well! 



Learn By Video
Design Fundamentals: Designing Effective Logos with Maggie Macnab

3.	 You can develop this particular sense after you have fully explored it in notes and 

drawings. Integrate any found objects from your walks, as well as ideas or visualizations 

that come up later—clippings, photos, or anything else relevant to you—and create 

a “designed sense” collage. Pay attention to the organization of your page. Design an 

initial cap or experiment with hand-drawn lettering styles. Be conscious of what is 

most relevant to you and how you can order, position, or prioritize with color, shading, 

boldness, and subtlety. Think about small relationships and how they can work together 

to create the whole relationship.

4.	 Experiment and find the best “sensual adjectives” to describe your sense. You can 

express these descriptions as colors, shapes, frenetic or careful drawing or marks, 

anything that feels appropriate. If you like, try the same concept with several different 

approaches. With each approach, take note of the things you can change compared to 

those you feel can absolutely not change. Identify why. This helps you to sort essential 

information from what can be eliminated.

5.	 After exploring each of the primary physical senses, try to find the time to take a walk 

and explore other sensibilities that range beyond the five physical senses. You can 

explore memories as they arise (what inspired them?), people or events that spontane-

ously come to mind (synchronicities), or how things fit together in patterns and shapes 

you observe. Don’t filter yourself; instead, concentrate on returning to the original intent 

each time you stray from it. 
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Chapter 2 Exercises: Language of Design and Form Fits Function

Learning the Language of Design 

This exercise will give you more fluency in the language of design.

1.	 Randomly choose five well-known brand logos. Select your group based on their 

diverse qualities.

2.	 Identify and name the extensions of the logos you have selected, such as brand, 

identity, icons, and specific extensions. 

3.	 Identify each logo’s type and note if any fall under more than one definition. 

Form Fits Function

When you understand how something is both constructed and designed to perform in the most 

efficient way, you have a deeper understanding of how form fits function and vice versa. This is 

an essential quality of good logo design. 

1.	 Observe traffic signs and signals when you are out and about. Make notes of them in 

your sketchbook, including the sign’s shape, symbol, and color. Do these elements rein-

force the meaning of the sign? How?

2.	 Do research on a product you use daily. Choose one of the following or make up one of 

your own:

■■ Spoon

■■ Shoe

■■ Bed

■■ Toothbrush

3.	 How does the item differ from culture to culture? Has it changed significantly in history? 

Why is it shaped the way it is? What material(s) is it made from? Why?
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Chapter 3: Sample Client Questionnaire

Asking your client pertinent questions before starting the identity design process has benefits for 

you both. It helps the client to consider and focus on objectives in a way they may not have con-

sidered previously, and it gives you essential information to lay a sound strategic foundation for 

the logo and brand. This list is not exhaustive, and you may come up with other questions that 

are specific to your situation, but it will get you thinking about the kind of information you need 

to know to deliver the best product possible. 

1.	 How is the organization structured? How is it managed?

2.	 How do you anticipate the organization evolving over the next five years?

3.	 What problems must you overcome to get there?

4.	 What trends affect your industry and how do you anticipate being able to 

accommodate them?

5.	 How does the company currently sell/present its products or services?

6.	 What does the company do well?

7.	 What does the company do not so well?

8.	 Who is your audience? What are their problems, needs, and wants?

9.	 What benefit can your company provide to your audience that they can’t obtain 

elsewhere?

10.	 How do you currently communicate with your audience?

11.	 Does the company have specific communications objectives?

12.	 What do you hope to achieve with a new identity program?

13.	 Use three adjectives to describe how the company should be perceived (examples: 

conservative, progressive, friendly, formal, casual, serious, energetic, humorous, 

professional).

14.	 Who are your competitors?
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Chapter 3.6 Exercise: Problem-solving, Upside Down and Backward 

This is an intuitive exercise to help you try out different ways of interpreting and solving prob-

lems. You’ll use yourself as a test subject to work on unexpected but meaningful solutions.

You’ll need a blank sheet of regular printer paper and a sheet of tracing paper. You’ll be creating 

a list of at least six descriptors for “difficulties” and six for “positives.” 

When you design following the flow of the message, you’re working with that message’s 

inherent power. As nature-artist Andy Goldsworthy describes it, “Everything has the energy 

of its making inside it.” Likewise, all problems inherently contain their own solutions. Find-

ing them often requires thinking differently. 

1.	 Think about a current issue or problem you’re having. 

2.	 On a sheet of printer paper, leaving at least ½-inch of space between each entry, list the 

downsides of the issue, one item per line. How does it negatively impact your life? How 

does it prevent you from moving forward? Make the list as concise as possible.

3.	 On a separate piece of tracing paper, list the positive aspects of solving the problem: 

What would be better if it were worked out? What other issues might it impact in a 

positive way if it was resolved? Again, one item per line, with ½-inch of space between 

each concisely defined entry.

4.	 Lay the tracing paper on top of the printer paper and turn it 90 degrees, so the lines you 

have written intersect one another at right angles. 

5.	 Look at how the negative interrupts the positive in physical ways. What words run into 

one another at the places they intersect on the two pieces of paper? Do any visual pat-

terns begin to emerge? Do common words repeat in both directions? See if similarities 

within opposite aspects can be reconciled. Find differences that can be transformed into 

complements. See if you can weave difficulties into positives and use them as a common 

leverage to solve the problem.

■■ An example:

Issue: I don’t ever have enough time.
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■■ Difficulties: 

I’m always stressed and tired.

I get upset with others when I’m pressured.

I blame myself and others, which doesn’t fix anything.

I react without thinking.

I can’t plan things I enjoy.

Other things always get in the way.

■■ Positives (if I did have more time):

My design work would be better.

I would have time for the things I enjoy.

I would be more relaxed.

I could think more clearly.

I could plan and prepare for the future.

I could be more responsive to problems and solve them.
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Chapter 4.2 Exercise: Learning to Refine

Refining complex information is an essential skill for good logo design. A good logo designer 

must sort, highlight, and eliminate visual information to arrive at the most effective design. This 

exercise will help you develop your refinement skills. 

Choose a photograph; a simple one works best. 

Analog: 

1.	 Put a piece of tracing paper over the image and tape it into place. 

2.	 Try to find the most distinctive parts of this image and roughly fill them in with pencil or 

black marker. 

3.	 Remove the first sheet of tracing paper and replace it with a clean one. 

4.	 Try the exercise several more times, each time with a new sheet of tracing paper in 

place, and try to remove as much information as possible with each attempt. 

The idea is to eliminate as much detail as possible while still retaining the essential 

information of the image. 

Digital: 

1.	 Scan or screen-grab a photo. 

2.	 Create a new document in Illustrator and place the image on a layer and lock it. 

3.	 Create a new layer. 

4.	 Using the pen tool, roughly construct lines around what you determine to be the most 

defining information of the image. 

5.	 Enclose the lines as shapes and fill. 

6.	 Toggle back and forth between the image, the outline of your work in preview mode, 

and the filled shape to continually check your relationships to the photo. 

Again, you’re attempting to get the most comprehension with the least amount of 

information. 

This exercise is about learning to see and bringing out the most important information to 

retain the integrity of the image. The goal is to have the image still convey what it is after 

eliminating as much unnecessary detail as possible. This will take a few tries so don’t get 

frustrated. The refining process is a skill that you learn by doing.
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Chapter 4.3 and 4.4 Exercise: Exploring Scalability

A good logo or logotype must scale well. This is not negotiable! Use this exercise to check the 

viability of various logos to retain their integrity from small to large sizes. 

Find a variety of logos and logotypes online or work with ones you’ve already created in 

Illustrator. Look for vectorized formats so that you can scale them without rasterization get-

ting in the way of your interpretation of their ability to scale. 

1.	 Open a logo in Illustrator and choose Select All. 

2.	 Experiment with scaling it up so it almost fills your screen, and then reduce it to a half- 

to a quarter-inch in size. 

3.	 How does it hold up? 

It’s inevitable that some information is lost in the process of applying the logo to different 

media and applications. What you’re looking for is whether or not the logo is still distinct 

enough to carry the intent of the original design. If not, look at what overwhelms the design 

at larger scales or what is lost at small sizes. What would fix these problems? 
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Chapter 4.6 Exercises: The Power of Empty Space

Being able to see reverse images hones your skill to create them in your own logos. The following 

exercises will support your development of this essential ability.

Exercise 1: Mind Toggling

1.	 Collect 10 to 20 black and white optical illusions that appeal to you and are at least 

somewhat challenging. Start with images first; you can move on to animations later if 

you want to. 

2.	 Practice seeing both empty and filled space. Consciously move your vision and mind 

between the two areas of negative and positive space. Practice this until you begin to 

naturally see both in new images. 

Tip: Look up M.C. Escher’s work.

Exercise 2: Create a Figurative Design Using an Effective 
Spatial Arrangement of Shapes (Illustrator)

You can use Illustrator’s background grid, go freeform, or create abstract arrangements. 

Shapes can be duplicated, overlapped, reflected, rotated, or otherwise turned in any direc-

tion in the document. The idea is to look for relevance in both positive and negative space 

and to try to create a meaningful design from random elements. 

1.	 Any shape can be duplicated, cropped, reflected, scaled, and so on.

2.	 Work only in black and white. 

3.	 Try to use minimal shapes to create an effective design; always simplify when you can.

Example:
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Chapter 4.7 Exercise: Shapes & Spaces Search

The process of elimination is another essential skill of a good logo designer. You have to know 

what to keep and what to eliminate to create effective visual communication—a relevant prac-

tice to all design but most particularly in logo design. 

Part 1. Look at a natural or human-made object, the space it occupies, and/or the ground 

around it. Sketch this item to see it better using your skills of observation. 

1.	 Is the space located on, behind, or within an object? 

2.	 Is it “positive” or “negative”? Is it proportionately smaller? 

3.	 Are there many voids or spaces found on this object, or only one?

Part 2. Shine a portable light source on a partner, piece of furniture, a sleeping pet, or any 

still life you would like to create. 

1.	 Trace a series of shadows from interesting parts of the body or object. These can be full 

figures or fragments. 

2.	 Focus only on the parts in shadow. What can be identified about the object using these 

shapes only? Simple and complex objects need different treatments when they’re sim-

plified into shapes. Notice how you might need to add information in simpler objects, 

while you must simplify more complex objects. 

3.	 Test your shapes out on people to see if they still retain enough distinguishing qualities. 

Which are the most successful and why?
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Chapter 5.5 Exercise: Create a Golden Section Spiral 

The following steps show you how to create a golden section spiral using Illustrator.

1.	 Draw a constrained square in Illustrator.

2.	 Place a vertical guide in the center.

3.	 Draw a constrained circle originating the center point where the guide intersects 

with the bottom side of the square. Expand the circumference out to the top corners 

of the square. 

4.	 Pull a rectangle out beginning from the lower left-hand corner of the square to the 

left circumference of the circle.

5.	 Delete the circle.

6.	 Pull a square out from the lower left-hand corner of the new rectangle and expand until 

it touches the left-hand side of the original square. 

7.	 Continue Step 6 four additional times as you work your way around, rotating the original 

phi rectangle. 

8.	 Create a second layer in the layer window.

9.	 Using the Arc tool, constrain it by holding the Shift key and pull it out from the top right-

hand corner to the bottom left-hand corner of the original square. 

10.	 Continue creating arcs in the same sequence as the squares built in Step 6. 

11.	 Delete your rectangle layer.

12.	 Select all arcs and Object>Path>Join.
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Chapter 5.7 Exercise: Create a Fibonacci Sequence Spiral 

The following steps show you how to create a Fibonacci sequence spiral using Illustrator.

1.	 Open Illustrator and the 5.7 Fiboannci_Spiral.ai file and turn on View Grid and Snap 

to Grid.

2.	 Starting in the lower right-hand third of your document (view the included finished 

Fibonacci Spiral in the exercise file to estimate the area), select your Rectangle tool and, 

while holding the Shift key to constrain proportions, draw a square spanning a 4 x 4 grid 

box width. Remember the sequence: 0+1 and then 1+1, which equals 2. 

3.	 This queues you to double the size of your previous square. Duplicate the first square 

(use Command-Option to drag and duplicate the square). 

4.	 Position the duplicated squares directly above the first square (this is why you have Snap 

to Grid turned on). Use Command-D to duplicate this process and create the second 

square of 2. 

5.	 Continue to create the number of squares necessary according to the next number in 

the sequence: after 2 will be 3 (2+1), after 3 will be 5 (3+2), and so on.

After you complete your rectangles (the combined squares always create rectangles of 

the same proportion), do the following:

6.	 Pull a circle out from the center point between the first two boxes using Command-

Shift-Option to constrain the proportions. Expand it until the circumference hits the 

bottom two boxes where they meet. 

7.	 Find each center point in the rotating pattern and continue to draw an enlarged circum-

ference for each per Step 4 above.

8.	 Connect the parts of the circle that intersect and delete the rest of the circle.

Hint: You can turn on the hidden Squares and Circles layers to check your work.
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Completed Fibonacci Spiral
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Chapter 6.3 Exercise: Create the Three Symmetries 

The following three procedures show how to create the three symmetries in Illustrator.

To create translation symmetry in Illustrator:

1.	 Select the element from which you want to create translation symmetry. 

2.	 From the toolbar, choose Effect > Distort & Transform > Transform. 

3.	 Enter the vertical or horizontal distance and the number of copies you want to make, 

and then select Preview to double-check the results. Click OK when you see the desired 

result. Keep in mind that software allows you to quickly make transformations, which 

allow for all sorts of variations that introduce more complex orders of symmetry, such as 

rotation and scaling.

To create reflection symmetry in Illustrator:

1.	 Select the element with which you want to create a mirrored effect.

2.	 From the toolbar, choose Effect > Distort & Transform > Reflect. Choose a vertical 

or horizontal orientation and the necessary degrees (typically 90° to create a simple 

side-by-side reflection). 

3.	 Preview your work. When it looks the way you want, click OK. Reflection symmetry can 

also be achieved using the Reflect tool in the Tool menu (located next to the Rotate tool). 

To create rotation symmetry in Illustrator:

1.	 Select the object to be rotated, and then click the Rotate tool in the Tools panel. 

2.	 Press and hold the Shift-Option keys, and click your center point of rotation.

3.	 The Rotate dialog box appears. Divide 360 by the number of rotations you want 

(for instance, threefold symmetry requires 120 degrees of rotation, which is the result 

of dividing 360 by three rotations), or more simply, you can key in 360/(the number of 

rotations you want to achieve) and click Copy. 

4.	 Check your work by clicking the Preview button. If it looks good, click OK. 

5.	 Duplicate the action by pressing Command-D to position the subsequent rotations 

perfectly into place.
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Chapter 6.7 Exercise: How to Create a Simple Tessellation

Here’s how to create a basic tessellation in Illustrator using a square or triangle shape.

To create a translation, or slide, tessellation in Illustrator:

1.	 Start with a document size that gives you enough room to move across and up and 

down on your artboard at least four times the size of the image you begin with. 

Make the width and height dimensions the same for this example as one that uses a 

square dimension. 

2.	 Click the Rectangle tool in the Tools panel. While holding down the Shift key to con-

strain dimensions, create a square (if you’re working with a graphic that is one inch by 

one inch, start with a document that is at least four inches by four inches). Or, click the 

Rectangle tool and then click the artboard to enter dimensions manually. 

3.	 For twofold translation, the dimensions are repeated in a line; for fourfold translation, 

the dimensions are repeated in rows and are alternated for glide translation (the same 

pattern that footsteps or the growth pattern of alternating leaves along the stem of a 

plant makes). 

4.	 Create your shape with the appropriate tool. For simple round shapes, use the Ellipse 

tool. For more organic or complex shapes, use the Pen tool. Overlap your new shape on 

the base square. 

5.	 With both shapes selected, choose Window > Pathfinder. The Pathfinder dialog box 

appears. Select Divide in the dialog box. 

6.	 Using the Selection tool, click the image. Ungroup the image by choosing Object > 

Ungroup. Use the Selection tool to choose the cutout shape and delete it. 

7.	 Choose Effect > Distort & Transform > Transform and enter the number of repetitions 

and distance for a linear design. 

8.	 For a tiled tessellation, you can enter distance information into the Vertical field in the 

Move area. 

9.	 The copied row or rows are clones and can’t be edited until you select the parent design. 

10.	 Choose Object > Expand Appearance to create an independent generation of the 

design that you can edit. 
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Chapter 6.8 Exercise: Create a Complex Tessellation 

Follow the procedures below to create a complex tessellation using Illustrator. Refer to the 

illustrated step-by-step example at the end of this procedure.

Creating a tessellation is challenging, but it’s fun and teaches you both software and 

conceptualization skills. Precision is essential when you create a tessellation. Enlarge your 

work with the magnifying glass when you’re clicking rotation points to be sure you’re dead 

on. An additional aid for this is to use outline mode Command-Y so you’re working with the 

actual outlines and not strokes. You can easily toggle between outline and view mode by 

clicking Command-Y again.  

1.	 Using the Illustrator document provided in the downloadable folder, create a triangle 

with your Shapes tool (this is an equilateral triangle by default) positioned on the 

center of the vertical guide. You’re using the polygon tool with three sides. Lock it 

(Command-2) to prevent it getting in the way for the next step.

2.	 With the Pen tool draw a random shape. A circle will appear on your Pen tool when 

the end of the line meets the beginning indicating you can join the two and create an 

enclosed shape. Click to close it (your shape must be enclosed to be a whole shape). 

The color default is usually a white fill with black outline. Change this to an empty fill so 

you can see where the shape is positioned over the triangle. Unlock the triangle so that 

pathfinder can recognize and combine these two shapes. 

3.	 Select both shapes with the Selection tool (black arrow), and in your Pathfinder dialog 

box (Window > Pathfinder) hold down the Option key and click the Divide Pathfinder 

(second row, first pathfinder tool). This will divide the two shapes where they intersect. 

The two shapes will automatically be grouped; ungroup them (Option > Ungroup, or 

just Command-U). With the Direct Selection tool (open arrow), delete the excess shape 

outside of the triangle area. 

4.	 This will leave a moveable piece that you’ll subtract from one side and add to the other. 

Move it out with the Selection tool to make sure it’s a separate piece, and then put it back 

into its original position with Command-Z. It’s essential for this to be precisely positioned 

when you rotate it to the opposite side. 

5.	 Select the new piece with the Selection tool. Choose the Rotate tool from the toolbox 

and Option-click the top point of the triangle dead center. This gives the rotation tool 

a center point to reference, and the Rotate dialog box will pop up. Enter 60 into the 
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Rotation Degrees field of the dialog box. This angles it perfectly to fit on the opposite 

side and drops it into place (remember, perfection is essential for a clean tessellation).

6.	 With the Selection tool, select both the piece on the right side of the triangle and the 

triangle. Click the top left Unite Pathfinder option. Voila! You now have a fused piece! 

(Note: If this is not precise, the Pathfinder tool will not unite the two pieces.)

7.	 You will now create the bottom shape. Remember to cut out only within the left- or 

right-hand half of the triangle baseline. Make a guideline to be sure you do not overlap 

into the other half of the triangle’s base and to create a point of reference for the rota-

tion tool again. Create a new shape using the steps above.

8.	 With the Rotate tool, Option-click the base of the triangle on the exact center to refer-

ence the center point. When the dialog box pops up, enter 180 as you’re cloning the 

opposite shape and rotating it upside down on the other half of the triangle’s base. 

9.	 Select both shapes and use Step 6 to combine them. 

Now you’re ready to start the imaginative part! Look at your new shape. What is living in 

there? This is where you begin to imagine what it will become. You may want to do this 

a few times to finesse your odd shape and intentionally create something. 

10.	 Select your new shape with the Selection tool. Select the Rotate tool and Option-click 

the top point (perfectly!) of the mutated triangle. This is your point of reference to rotate 

the shape six times. The Rotate dialog box will pop up. Enter 360/6 as you are now mov-

ing the object a complete 360 degrees and it will take six rotations of the design to com-

plete the circle. (Note: You’ll want to colorize; I recommend at least two different color 

sets so that the object is clearly defined in each rotation, and add any interior drawing 

lines before you start duplicating it so that you only have to do this involved process 

once. Be sure to select Copy so the Rotate tool knows to make extras.

11.	 After you’ve created your first rotation of a total of six, use Command-D to duplicate 

your selection. Continue until they fill the rotation space. 

12.	 Copy your group of six and slide it to perfectly fit and fill your page. 

You have just accomplished an extraordinarily complex piece of geometry using Illustrator 

skills and your creativity and imagination to the maximum degree!
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Chapter 7 Exercise: Logo Gestalt Hide and Seek

Many gestalt principles combine with each other, but there is often a dominant characteristic 

that will clearly identify one gestalt over another. This exercise allows you to become more 

attuned to seeing and sorting the principles and to learn how they function within the logo. 

1.	 Using a magazine, a book, or the Internet, find a variety of logos that combine elements. 

2.	 Identify as many of the five gestalt principles as you can within 10 to 15 minutes.
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Chapter 7 Exercise: Shape Gestalt 

Using the basic shapes—square, circle, triangle, intersecting lines, and spirals—have the 

shapes interact with one another to demonstrate the five gestalts. They can overlap, be side 

by side, follow a path, or combine in other ways to express continuity, closure, proximity, 

figure/ground, and similarity. You can use pencil, pen, or Illustrator. Work in black and white. 
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Chapter 8 Exercise: Develop the Story as a Visual 

Learning to develop a visual story is essential in creating a meaningful logo. In this exercise, you’ll 

experiment with developing a story from your own experience to create a meaningful symbol. 

Remember that logos are necessarily simple and concise. Your images should be refined to their 

simplest iteration.

1.	 Remember back to an important event in your life. Happy, sad, or terrifying, it doesn’t 

matter. Work with an experience that made a significant impact on you.

2.	 Begin doodling. Images may come to mind instantly, or you may just start with abstract 

shapes. Angles help to express edginess while curves indicate smoothness or a gradual 

transition. Work with this process until you feel as though you have accurately expressed 

this experience in images, symbols, or abstractions. 

3.	 Study the images you’ve created. Look for the images that affect you emotionally. This 

helps to identify the authenticity of the visual to the experience. 

4.	 You may have ideas that you want to explore further. Don’t feel as though you have to 

push this exercise; you can return to again and again. Visual storytelling takes time to 

get right. 

5.	 Can you combine several of your images to make the story more succinct? 

This exercise is about finding and combining images to tell a story. It is not about being able 

to draw but about identifying the most important elements of a story you wish to tell. Work 

with the images until you feel they convey the experience you had in the most accurate 

way. Then share it with others and consider their reactions. 
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Chapter 9.2 Exercise: Individualize the Cliché

In this exercise you’ll customize a cliché to turn it into something new and fresh. You’ll take an 

everyday expression and transform it into a design tailor-made for a client, stretching your ability 

to think beyond the obvious. 

Take one or more of the standard expressions listed here (each of which was selected for its 

visual qualities) and combine with the invented client to create a unique logo concept. You 

don’t necessarily have to create a logo, but think about the visual options that would create 

a memorable logo and do a few conceptual sketches. 

“A rose by any other name” for a composting company

“Bent out of shape” for a metal-working company

“All ears” for a hearing aid company

“Airing dirty laundry” for a laundromat

“Making waves” for a surf shop

“Second banana up” for a leadership/mentoring service
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Chapter 9.4 Exercise: Designing Metaphors

Metaphors link concepts together. This design exercise will help you learn how to create a logo 

based on a metaphor. When it’s done well, this is one of the most powerful ways to relate the 

logo to the audience, so take your time and try it out on more than one concept. 

1.	 To prepare your mind, eyes, and creativity for this exercise, look at examples of visual 

metaphors. You can do a search on the Internet. 

2.	 Choose a topic to visually describe as a metaphor. Examples would include support ser-

vices for runaways, intellectual learning skills, or a training service for seeing-eye dogs. 

Or come up with your own idea. This could be something you’re already interested in 

and would like to explore further.

3.	 Your basic question is: What kinds of metaphors will make the simplest and most direct 

visual associations? Visually brainstorm a variety of ideas and create quick sketches and 

word lists to remember them. For example, if you’re brainstorming for a seeing-eye dog 

service logo, you’d probably think of things like a dog’s face, support, help, loyalty, sun-

glasses, a cane, the banner service dogs wear in public, or Braille. Leave yourself open to 

whatever comes to mind and make a sketch or note of it. This is an associative exercise; 

whatever you associate with the concept is relevant (although some metaphors will be 

stronger than others). 

4.	 Review your visual metaphors and deconstruct them further. Again, using the seeing-

eye dog service example, you might deconstruct one of the most obvious attributes of 

this service: blindness, perhaps, or the dogs themselves. Look for further associations as 

words such as: 

■■ Dogs:

Loyal helpers

Doe eyes

Furry

Affectionate

Smart
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■■ Blindness:

Sunglasses

Braille

Touch

Cane

5.	 Distill your source metaphors down to the most effective ones and that work well with 

other visual metaphors. For example, you might put sunglasses on a German shep-

herd’s face. Keep in mind this concept could be construed as “cool” instead of relating to 

“blindness,” so think of other ways to integrate relationships between the images. Some-

thing that might more clearly suggest the service is the full body of the dog wearing the 

service banner (possibly an opportunity to put the company name or a message on it). 

Another potential idea for a seeing eye service based on the lists provided could be a 

business card that uses a blind emboss of letters composed of dots, similar to Braille, but 

legible to all. The service might simply be called “Good Dog Seeing-Eye Service.” Work 

to simplify your ideas but always focus on what communicates the most effectively. 

6.	 From the visual and word lists you have generated in this exercise, experiment with the 

most promising concepts and see if they prompt thoughts on how they can be com-

bined as visually linked associations.

7.	 Take your ideas from this exercise and use them to generate potential logo design 

concepts. 
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General Pattern Exercises

Review videos for Chapters 10 through 15 and then try out these three pattern exercises that will 

allow you to observe, identify, and recreate patterns.

In Pattern Exercise 1, Walk the Nature Talk, you’ll identify patterns by getting outside and finding 

them in nature. In Pattern Exercise 2, Find the Essence of Patterns, you’ll learn to really observe 

patterns by studying them closely for a period of time. Pattern Exercise 3, Express Pattern as 

Design, includes a short how-to on creating a vector from a natural pattern with a downloadable 

file; you’ll also be able to more finely hone your observation and execution skills. 

Pattern Exercise 1: Walk the Nature Talk

Level: Easy

Get your sketchbook and pencils, and take them with you on a walk. 

1.	 Focusing on natural forms only (not buildings, sidewalks, or anything else human-made), 

try to identify each of the five patterns discussed in the previous chapters about pat-

terns: branching, meander, spiral, helix including waveforms and weaving patterns, and 

stacking and packing shapes. As you find them, sketch them in your book and identify 

what pattern you think is dominant in the objects you’re observing. 

2.	 Look a little deeper. What does their form tell you about what kind of work they do 

(moving, storing, connecting)? Can you identify what the pattern is doing in context of 

how it’s used? 

3.	 Is there more than one pattern working together? How do they interact or support 

one another? 

Pattern Exercise 2: Find the Essence of Patterns

Level: Intermediate to Advanced

Any significant human discovery has come by accident or observation, or a combination 

of the two actions. The best-case scenario uses both actions because the human mind and 

heart are designed to work together. The mind rationalizes with its intellect, while the heart 

feels its way to the right solution. While you can’t force yourself to be more inspired, you 

can create more opportunities to experience inspiration and creativity by engaging both 

your heart and mind. This exercise will allow you to flex your thinking and feeling powers by 

experiencing them in both analog and digital technologies. 
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Part I: Observing Patterns 

Learning to observe what you see.

Take your sketchbook outside and choose an object to draw every day for a week. You don’t 

have to be an artist to do this. This exercise isn’t about realistic drawing skills or making a 

perfect piece of art. It’s about really looking at what you see. Make notes about your obser-

vations, and if possible, collect actual samples of your subject and keep them in your book 

if they’re flat or in a separate container if not. For example, if your subject is a tree, you can’t 

put a branch into your sketchbook, but perhaps a leaf from a branch would do. Remember 

to observe the parts as well as the whole. Take photos if you want to, but keep in mind that 

a photograph is a representative artifact and doesn’t show life’s true movement or interac-

tion. Spend at least 15 minutes each day with this exercise, and more if you can.

1.	 Choose a subject in nature. This will be your drawing matter for the week. It can be an 

animal, vegetable, or mineral; it’s your choice. It’s best to do this outside, but if you’re 

experiencing inclement weather or it’s too difficult to get out and into nature on a daily 

basis, choose a houseplant or a pet, or look out the window. 

2.	 Get a feel for the overall structure. Create “gesture” drawings. These are quick, broad 

drawings without detail. Find the feel for the object you’re drawing. What clues do you 

see in it? Is it sharp and angular or flowing and smooth? Perhaps it has both features, like 

a cat has both soft fur and sharp claws. Do several drawings in a few minutes; set a timer 

if you like and do one drawing every 30 seconds.

3.	 Don’t change the subject. Focus on one object or entity every day for a week. How 

many angles can you observe it from? How many different gestures can you find in it? 

Create a relationship with it through consistent observation. 

4.	 Identify the pattern(s). Which are dominant? Are there secondary or tertiary patterns? 

Make notes about your findings as visuals or words. 
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Part II: Detailing Patterns 

Everything is in the details.

You should be fairly intimate with the object you have spent a week observing and 

sketching. 

1.	 Choose a detail from your nature subject. What attracted or intrigued you most when 

you created the gesture drawings? This is what you’ll focus on.

2.	 Explore this one detail. What pattern is it related to? Is it obvious what purpose this 

pattern is serving in this particular context? (For example, if it’s linear, what is being 

transferred: sunlight, water, food? If it’s a spiral, what is generative or creative or con-

necting about it? If it’s an enclosed shape, what is being stored?) Note your observations 

to prepare for the next exercise. 

3.	 Explore your subject to its fullest and transform its literal context into an abstract 

one. You should now be familiar enough with your subject to take liberties with styl-

izing it. Go through your notes and sketches, and find the most prevalent shapes and 

patterns to prepare for the next exercise. 

Pattern Exercise 3: Express Pattern as Design

To be an effective logo designer, you must learn how to identify and extract valuable informa-

tion. The entire series of pattern exercises is designed to give you a true working context of 

observation, interaction, refinement, extraction, elimination, and reordering, while using critical 

thinking skills at all stages of the process.

A Pattern Examples PDF file has been included in this folder to show how others have interpreted 

this exercise. 

In this exercise, you’ll choose three or four different ways to represent your subject to com-

municate the dominant pattern. The accompanying slide show demonstrates different ways 

previous students have problem-solved this exercise and found different ways to interpret 

and present patterns they chose from nature. 

This exercise will enhance your overall skill of observation as you create sketch studies and 

refine the overall pattern into a highly stylized vector illustration. This will help you to iden-

tify and replicate patterns by observing, defining, and recreating them in different media. 
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1.	 Create a realistic drawing. Draw your subject as accurately as you can with your choice 

of media (pencil, colored pencils, pen, and so on). If the subject is too detailed and you 

find it overwhelming to draw the entire object, pick a part of it and focus on that. 

2.	 Explore your subject in three dimensions. Take an aspect of your subject (or the 

whole subject, if you care to), and create a three-dimensional representation of it. You 

can do this with paper folding, craft materials, or natural materials. Observe the primary 

movements or shapes of patterns to help define a three-dimensional representation that 

accurately conveys the pattern. Origami is not difficult to do, and you can find all sorts of 

instructional videos on the Internet on how to create different folded and bent forms. 

3.	 Create a detail. Find an aspect of your natural object to detail. Many students have 

explored micrographs of their subject via online searches and discovered a common 

shape or pattern that scales throughout their subject. This process unmistakably leads 

you to essential information about the object. This can be an edge, a shape, or the 

overall pattern refined into a simplified detail of it. 

4.	 Stylize the form. From the previous parts of the exercises, identify the dominant pat-

tern you’re working with and stylize it as a black-and-white vector illustration created in 

Illustrator as a repeating form. (For an example, see the video in the Chapter 10 folder of 

a branch of mistletoe transformed into a stylized vector.)
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Chapter 11: The Branching Pattern Defined

Definition: The branching pattern shows energy moving from one place to another with 

urgency and directness. 

Branching Purpose: Branching is an angular pattern with purposeful linear movements 

that show direct intention, efficiency, and interaction. The energy of branching contains 

immediacy and efficiency (directness implies urgency).

Branching Examples, Natural: Branching corals, river tributaries, brain dendrites, leaf 

veins, trunk extensions in trees or animals, fingers, circulatory and nervous systems.

Branching Examples, Human: Direct road systems (highways, city grids), family trees, 

circuitry, hierarchical structuring in governments, businesses, or religions. 



Learn By Video
Design Fundamentals: Designing Effective Logos with Maggie Macnab

Chapter 11 Exercise: Explore the Branching Pattern

The purpose of this exercise is to observe and identify the branching pattern in nature and in 

human-made objects that follow nature’s principles. When you can do this, you’re able to effec-

tively embed this particular principle of nature into a logo design to support its communication.

Part 1. Find a minimum of five branching patterns in nature. Be imaginative and look 

beyond the literal branches of plants or trees. Be aware that you’re looking for core aspects 

of branching as a pattern, that is, don’t mistake the edges of things as this pattern. You’re 

looking for an inherent quality. Think in terms of systems that move things or energy.

Part 2. Look for a minimum of five human-made designs that embed the branching pattern 

as an inherent quality of the design. Be creative with your thinking; for instance, the lines 

of type that compose a page of a book or beams that support the structure of a roof have 

this quality.

Part 3. What kinds of clients might this pattern be appropriate for? Make a list of at least 

three businesses or organizations along with a brief explanation of why the pattern fits. 
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Chapter 12: The Meandering Pattern Defined

Definition: Meandering patterns visualize the pattern of energy moving from one place to 

another in a relaxed, distributed movement. 

Meandering Purpose: Meanders show patterns of movement that are wandering, and a 

loosely diversionary method of delivery or spreading. Meandering is circuitous and efficient 

over a body of space with more comprehensive distribution. 

Meandering Examples, Natural: Animal paths and trails, brain coral, brain convolutions, 

winding valley streams, intestines.

Meandering Examples, Human: Human paths and trails, labyrinths, decorative borders 

popular in art and architecture from the Mediterranean to Native American pottery designs 

called Greek Key or Greek Fret patterns.
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Chapter 12 Exercise: Explore the Meandering Pattern

The purpose of this exercise is to observe and identify the meandering pattern in nature and in 

human-made objects that follow nature’s principles. When you can do this, you’re able to effec-

tively embed this particular principle of nature into a logo design to support its communication.

Part 1. Find a minimum of five meandering patterns in nature. Be imaginative and remem-

ber that more than one pattern can be contained in one object. Be aware that you’re look-

ing for core aspects of meandering as a pattern. Don’t mistake an edge of an object as the 

inherent pattern (although an edge can be indicative of it). Remember to look beyond hard 

materials like earth; also look at sky, water, and all the elements to find this pattern. (Hint: 

Sand dunes and clouds contain this quality.) Undulation implies fluidity and fluidity implies 

processes that are moving and ever-changing.

Part 2. Look for a minimum of five human-made designs that embed the meandering 

pattern as an inherent quality of the design. Be creative with your thinking. Why was this 

pattern used in this particular design? Learn to associate form with function. For example, 

a country road follows the undulating curves of hills and valleys in the same way a 

stream would. 

Part 3. What kinds of clients might this pattern be appropriate for? Make a list of at least 

three businesses or organizations with a brief explanation of why the pattern fits. 
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Chapter 13: The Spiral Pattern Defined

Definition: Spirals express the pattern of energy regenerating itself, an act of creativity 

(although energy itself is not created or destroyed). This pattern extends into the future 

through the connection of self-similar progressions.

Spiraling Purpose: Spiraling is an ever-expanding pattern of curves that progress geo-

metrically outward (logarithmic spiral) or coil in successive turnings that have a constant 

distance of separation (Archimedean spiral). 

Spiraling Examples, Natural: Mollusks, plant tendrils, hurricanes, the pattern rose petals 

follow around their seed head, fingerprints, vortices.

Spiraling Examples, Human: Staircases, Celtic knots, the Golden Mean (you can learn to 

create a golden and Fibonacci spiral in another video).
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Chapter 13 Exercise: Explore the Spiraling Pattern

The purpose of this exercise is to observe and identify the spiral pattern in nature and in human-

made objects that follow nature’s principles. When you can do this, you’re able to effectively 

embed this particular principle of nature into a logo design to support its communication.

Part 1. Find a minimum of five spiraling patterns in nature. Be imaginative and remember 

that more than one pattern can be contained in one object. Be aware that you’re looking for 

core aspects of the spiral as a pattern. The spiral pattern is associated with new growth, cre-

ativity, and regeneration; keep these principles in mind as you look for the pattern in nature. 

Part 2. Look for five human-made designs that embed the spiral pattern as an inherent 

quality of the design. Be creative with your thinking. Why was this pattern used in this par-

ticular design? Learn to associate form with function. Architects have used this pattern in 

the structuring of buildings such as museums and residences. See how many ways you can 

find it used in human-made designs.

Part 3. What kinds of clients might this pattern be appropriate for? Make a list of at least 

three businesses or organizations with a brief explanation of why the pattern fits. 
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Chapter 14: The Helix Pattern Defined

Definition: Helices express the pattern of energy regenerating itself but this pattern 

is more typically seen at miniscule (DNA) or gigantic (some nebulae) sizes. This pattern 

extends into the future through the mingling of the DNA of two parents in a helical pattern. 

It has a singular diameter that emphasizes its principle of concentrated penetration, rather 

than the expansive or contracting aspects of the spiral as an active growth process. 

Helices’ Purpose: The helix is a concentrated form of energy funneled precisely and direct-

ly with purposeful intent. 

Helix Examples, Natural: Spider webs, genetic materials, waterspouts, black holes. 

Helix Examples, Human: Staircases (they come in both helix and spiral shapes), the medi-

cal caduceus, woven fabrics, balanced cultural integrations within individual countries.
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Chapter 14 Exercise: Explore the Helix Pattern

The purpose of this exercise is to observe and identify the helix pattern in nature and in human-

made objects that follow nature’s principles. When you can do this, you’re able to effectively 

embed this particular principle of nature into a logo design to support its communication.

Part 1. Try to find a minimum of five helical patterns in nature. (Hint: Weaving is a helical 

pattern). If you have trouble finding this many, don’t be discouraged. I don’t expect you to 

locate a waterspout! If they’re things that are too miniscule to see or too dangerous to come 

into contact with, describe them instead. You’re looking for core aspects of the helix as a 

pattern. This pattern is associated with new regeneration more than it is with growth. It’s 

therefore hard to find at a human scale, or can be a bit dangerous in close proximity. 

Part 2. Look for five human-made designs that embed the helix pattern as an inherent 

quality of the design. Be creative with your thinking. Why was this pattern used in this 

particular design? Learn to associate form with function. Remember its use as a tool from 

the video and think along the lines of penetrating, drilling, weaving, or strongly connecting 

things together. 

Part 3. What kinds of clients might this pattern be appropriate for? Make a list of at least 

three businesses or organizations with a brief explanation of why the pattern fits. 
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Chapter 15: The Stacking and Packing Pattern Defined

Definition: Stacking and packing patterns are derived from the multiple spherical and 

cylindrical shapes in nature that compress into angled shapes when pressurized. They’re 

often comprised of 120 degree angles or hexagonal shapes (a circle collapses into a six-

sided shape when compressed). 

Stacking and Packing Purpose: Stacking and packing patterns store energy in a stable 

and accessible way until it’s needed. 

Stacking and Packing Examples, Natural: Beehives, wasp nests, cracked mud, settled 

layers of stratified rock, the scutes of a tortoise’s exoskeleton, snowflakes.

Stacking and Packing Examples, Human: Money, built environments, catacombs, 

modular furniture, fencing, grates, air filters that capture contaminants, and Chinese Ru 

ware crazing.
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Chapter 15 Exercise: Explore the Stacking and Packing Pattern

The purpose of this exercise is to observe and identify the stacking/packing pattern in nature 

and in human-made objects that follow nature’s principles. When you can do this, you’re 

able to effectively embed this particular principle of nature into a logo design to support its 

communication.

Part 1. Find a minimum of five stacking and packing patterns in nature. (Hint: Remember 

that a stacked/packed pattern doesn’t always create a perfect hexagon. It’s a product of 

pressure and gravity collapsing a spherical shape into a tight fit; a seed head is an example 

of the stacking and packing pattern.) Stacking and packing patterns store energy in a stable 

and accessible way until it’s needed, so think in terms of the kinds of things nature would 

store until needed or ready. 

Part 2. Look for five human-made designs that embed the stacking and packing pattern as 

an inherent quality of the design. Be creative with your thinking. Why was this pattern used 

in this particular design? Learn to associate form with function. Human beings model their 

designs on natural designs because they’re so effective. For example, eggs are spherical-like 

and fragile. Therefore, egg cartons were designed as a solution for storing them. 

Part 3. What kinds of clients might this pattern be appropriate for? Make a list of at least 

three businesses or organizations with a brief explanation of why the pattern fits. 
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Chapter 16: An Introduction to Shapes: Degrees of Freedom

Degrees of freedom is a scientific term that refers to orders of dimensional space. Degrees of 

freedom references the autonomy higher dimensions have over lower ones. As examples 

we’ve all personally experienced, think of the freedoms an adult has over a baby, or a flower 

has to a seed. As the animation in the video series shows, dimensions directly relate to 

the fundamental geometric shapes and they, in turn, directly relate to the communication 

embedded in your logo design. What follows are basic descriptions of each degree of 

freedom and how they’re constructed from geometry.

The point. The point is a fundamental object of Euclidian geometry. The point solely refer-

ences a location in space and has no other properties. If it were a space, it would be a space 

in which there is only one possible position, therefore, it has a zero degree of freedom, or 

is a zero-dimension object. All circles have a center point at their origin, just as you have a 

navel at the center of your body’s beginning.

The line. When you “push” a point in space you create a line segment, or a one-dimension 

of space. This horizontal line extends infinitely in both directions and is usually called the 

x-axis and has one degree of freedom, or a position of only being a line in space.

The plane. The plane enters into the realm of shape with a third point that, when con-

nected with the other two, encloses a two-dimensional surface. The plane has two degrees 

of freedom, or is a shape that can be measured with two numbers (the x- plus y-axis) to fix 

its position in space. 

The tetrahedron or cube. Depth is brought into the equation with a fourth point, the z-

axis. Drawing a cube or tetrahedron is a little laborious to describe three-dimensional space 

and so we often refer to the four points of three-dimensional space as a square or four-

sided shape. The square is a universal symbol for the tangible solidity of three-dimensional 

space. The tetrahedron contains the three axes of width (x-axis), height (y-axis), and depth 

(z-axis), or three degrees of freedom. 

The representation of a third dimension on a two-dimensional surface is created by an 

illusion. Another way to visualize this is to actually construct the cube in three-dimensional 

space. It’s easy to do and will give you some hands-on experience with package 

design (however, at its most simplistic level!). Try other shapes in three dimensions to 

better understand how they work. There are many references online to show the basic 

construction from simple to complex package designs. 
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By thinking in detail about how you can use degrees of freedom to extend ideas from a lower-

dimensional space to a higher-dimensional space (physics), you’ll be able to see the basic 

constructions that form all material objects in nature (geometry), as well as how these objects 

develop from nothingness (philosophy). This is how the rules of simplicity progress as increasingly 

complex conceptual theories that take you far beyond everyday experience. The designer’s 

familiarity with the fundamental workings of the universe support design that is effective, 

beautiful, and universal.
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Chapter 17: The Circle Defined 

Definition: The circle is all encompassing. Just as the fertilized egg contains the blueprints 

within its circular shape to create any body part needed, the circle contains all other shapes 

within it that can be realized through geometry. The circle symbolizes wholeness, connec-

tivity, independence, and/or movement.

Dimension: The circle begins with only a location in space represented by a single point, 

or zero dimension. It’s expanded into its full shape by drawing an infinity of points that are 

connected as a line. 

Archetype: The circle contains all within itself and excludes all that is without. It is both 

whole and hole, and all and nothing (as in zero). 

Emotion: Negative: Aloofness, isolation. Positive: Self-starter, independence, sacrifice of self 

for the overall “whole.” 

Purpose: The circle is wholeness personified. As such, it expresses working independently 

and autonomously or towards a greater good in teams. 

Natural Expressions: Germs, cells, viruses, planets, stars, bubbles, eggs, seeds and their 

extensions of trunks and stems, revolutions of the seasons, and planets. 

Human-made Expressions: Sports balls and stadiums, religious artifacts (halos, stained 

glass, Dharma wheel, yin yang), and ceremonial or institutional structures (Stonehenge, 

kivas, cathedral or governmental domes).

Types of clients this shape would be appropriate for: Community organizations,  

non-profits, comprehensive services or groups, whole-thinking businesses.
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Chapter 17 Exercise: The Circle

Look for three identities within your community or on the Internet that integrate the circle 

as a primary template of the logo design. How does the circle help to support their mission 

and/or how is it relevant to what they do?
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Chapter 18: Intersecting Lines Defined 

Definition: The line is the point’s first foray into space. By extending itself beyond a singular 

position, it creates one-dimensional space. The line is defined in a literal and linear way. 

Intersecting lines (equidistant cross or plus symbol) are the shape of relationship: Two 

opposites combined at their intersection or point of relationship. 

Dimension: The line is one dimension. 

Archetype: The line is created by cloning the circle and connecting the two circle’s center 

points together. Its partner, the opposite line, is constructed by joining the points of overlap 

between the two circles. The lines both separate and join opposites together through the 

intersection of the vertical and horizontal lines. It can also be constructed within the circle 

as two half-sized “daughter” circles to create the yin yang shape.

Emotion: Negative: Linear, logical, unable to integrate other perspectives; Positive: Complete 

precision and relationship oriented. 

Purpose: The line connects in the most rudimentary way. Not typically used alone in logo 

design, it is still an essential element to all other constructions that follow and can be used 

to lead the viewer’s eye, just as a pathway does. Two intersecting lines create the archetypal 

symbol of opposites in a relationship. 

Natural Expressions: The horizon, rivers and streams, edges between ecosystems, and as a 

tracing of the paths of other objects. 

Human-made Expressions: Roads, suspension supports, power lines, the Christian cross, 

the division between empty and filled space in the yin yang symbol, plumb bob, ruler, trails 

and paths.

Types of clients this shape would be appropriate for: Overlapped circles or the pro-

gression of intersecting lines are shapes that suggest partnerships, relationships between 

diverse businesses, or cooperation/collaboration.
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Chapter 18 Exercise: Intersecting Lines

Look for three identities within your community or on the Internet that integrate intersect-

ing lines as a primary template of their logo design. How does this shape help to support 

their mission and/or how is it relevant to what they do?
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Chapter 19: The Triangle Defined

Definition: The triangle is the shape of aspiration and higher goals. It embodies this in its 

shape of a broad base that funnels into a point. As an example of our personal experience 

of this, one night go outside and look up at a star. We stand on solid ground with a tangible 

horizon all around us, the horizontal line of our real world experience. But we also look 

up at the stars and wonder about what lies beyond our experience, the point beyond our 

reach. This shape combines the first two dimensions of point and line into a transformation 

or movement that allows for progression into the next dimension.

Dimension: The triangle connects the line with a third point to enclose a plane as a  

two-dimensional space.

Archetype: The triangle is a line and a point combined, and serves to direct broader 

concepts into a refined and focused point. The arrow symbol is exemplary of this. 

Emotion: Negative: Continual aspiration without real-world results, a dreamer; 

Positive: Stability, inspiration, and ability to transcend obstacles. 

Purpose: The triangle is the shape of energy gathered and compressed to prepare for 

transformation.

Natural Expressions: Mountains, high-elevation trees (such as pines), some leaves and 

fern fronds, 120° angles created by drying mud or pressure-cracked rocks, faces of crystals 

and other two-dimensional surfaces.

Human-made Expressions: Religious and transformative symbolism, pyramids, monu-

ments, triangle (the tool), all angles including the expanded compass. 

Types of clients this shape would be appropriate for: Businesses associated with goals, 

higher aspirations, security and precision, and transformation.
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Chapter 19 Exercise: The Triangle

Look for three identities within your community or on the Internet that integrate a triangu-

lar shape as a primary template of their logo design. How does this shape help to support 

their mission and/or how is it relevant to what they do?



Learn By Video
Design Fundamentals: Designing Effective Logos with Maggie Macnab

Chapter 20: The Four-Sided Shape Defined

Definition: The four-sided shape indicates durability, stability, and manifestation. It embod-

ies rigidity and solidness. 

Dimension: A fourth point is added to the plane, bringing depth, or the z-axis, to manifest 

energy into three-dimensional space. This is the dimension in which we live: the real world. 

Archetype: The four-sided shape is tangible space: what you experience every moment of 

every day as a living being. Most of the built world—including the city grids—is based on 

the four-sided shape, a shorthand for the fourth point of the tetrahedron that creates the 

z-axis of three-dimensional space. 

Emotion: Negative: Sternness, rigidity, addiction; Positive: Stable and supportive. 

Purpose: Four-sided shapes structure the built world as a human-made form.

Natural Expressions: There are some squarish-shaped broken rocks and cracks in nature, 

but no true squares. Some crystals, such as salt, sugar, and crystallized soy sauce, have 

squarish shapes at molecular scales. 

Human-made Expressions: Just about everything you see around you: windows, doors, 

walls, monitors, tables…everything! The built world is based on the four-sided shape. Finan-

cial, insurance, and mega corporations often use this shape to imply stability. And obviously, 

so do building contractors. 

Types of clients this shape would be appropriate for: Businesses or organizations who 

want to imply complete stability, control, immobility, or literal manifestation. 
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Chapter 20 Exercise: Four-Sided Shape

Look for three identities within your community or on the Internet that integrate a square or 

rectangular shape/s as a primary template of their logo design. How does this shape help to 

support their mission and/or how is it relevant to what they do?
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Chapter 21: The Spiral and Star Shapes Defined

Definition: The spiral is the shape of regeneration and creative connectivity (as opposed to 

linear connectivity). The spiral is a dynamic form that equalizes and brings oppositions into 

balance. The star is symbolic of human form and excellence.

Dimension: The spiral represents the fourth dimension of time. Time is always new and 

yet cycles with the seasons. The same holidays come again and again, and you celebrate 

your birth with each new sun cycle marking it. The spiral regenerates a prior pattern as a 

new thing.  

Archetype: The spiral winds around itself. It continually revisits and continually renews. 

Stars contain a spiral within their geometric form when curves are added to angles. 

Emotion (both star and spiral): Negative: Inability to stay with new projects through 

completion (the thrill of the conquest without commitment), an obsession with perfection; 

Positive: Generative, innovative, great facility to experiment with new ideas and things. Com-

mitment to the highest standards.

Purpose: The spiral renews and regenerates. The star is associated with humanity and 

excellence.

Natural Expressions: Spirals: tornados, water spouts, snail and mollusk shells, unfurling life, 

the shape of the human ear. Five-Pointed Stars: the number of extensions from the torso, 

the number of flower petals from plants that grow edible fruit, the basic human senses, our 

fingers and toes.

Human-made Expressions: Staircases (usually a helical shape), half of the traditional heart 

symbol that expresses “love,” jewelry, art, labyrinths. Stars are used as a symbol of excel-

lence for national flags and military insignia, and are symbolic aspirations of achievement in 

excellence ratings. 

Types of clients this shape would be appropriate for: Businesses or organizations con-

cerned with highest achievement, creativity, regeneration; governmental organizations. 
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Chapter 21 Exercise: Spiral and Star Shape

Look for three identities within your community or on the Internet that integrate spirals or 

stars as a primary template of their logo design. Spirals are associated with creativity and 

regeneration, while stars represent the highest standards. What kinds of clients might want 

to identify themselves in this way?
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General Shapes Exercises

Review videos for Chapters 16 through 21 and then try out these three shapes exercises that will 

allow you to create your own personal symbol and see how to deconstruct a corporate logo.

Shapes Exercise 1: Shape Preference Warm-up

Level: Easy

Now that you understand the principles of basic shapes, let’s try using them as a starting 

place to create a personal symbol. 

1.	 Of the five shapes described (circle, intersecting lines, triangle, four-sided shapes, and 

spiral), order them by your preference. Don’t think about this; just choose them in the 

way that feels right to you.

2.	 Take the first, third, and fifth shape from your list and begin to blend them into a com-

posited sketch that appeals to you. You can do this by hand, or you can create a more 

finished looking draft in Illustrator. Create several different possibilities.

3.	 Blend the shapes into a refined single design as much as possible. The idea is to get 

cooperation going between what you see as a priority (the first shape you chose), what 

your core leaning is (your third shape choice), and those principles that are not as strong 

or important to you (your last shape choice). 

4.	 Refer to the definitions included with the various shape videos to see if their descrip-

tions fit you. For example, if you have a spiral in position one, a triangle in position three, 

and a square in position five, the positioning implies that creativity is a priority to you 

(#1); stability is not (#5); and you lean toward setting goals and inspiration as a core per-

sonality trait (#3). This is a warm-up for the next exercise.
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Shapes Exercise 2: Create Your Own Personal Symbol 

Level: Moderate to Complex

Using the shapes from Exercise 1 as a starting point, you will develop a personal symbol. 

This gives you practice creating a new entity by combining essential parts that don’t have 

specific meaning alone. You can start with your shapes but you don’t need to limit yourself 

to them. For examples of how others have created personal symbols beginning with the 

shapes preferences from Exercise #1, see the enclosed Personal Symbol Examples pdf.

1.	 Think about what is truly important to you. Make a list, create a thought cloud, or doo-

dle ideas that represent various ideas. Whatever fits for you is the right way to do it. 

2.	 Pull from these ideas the juiciest, most wonderful things that you love or that spark your 

interest. What is your passion? No holds barred; this is your symbol and it’s anything you 

want it to be. 

3.	 Keep your shape selections from the previous exercise in mind, but don’t limit yourself 

to them. You can use them as a place to start or they can become integrated as a part of 

the personal symbol’s template. 

4.	 Begin combining your ideas as visual composites. Find places they match up—similar 

shapes or common metaphors that might represent more than one idea. How can you 

begin to merge concepts in a way that makes visual sense? 

5.	 Remember that you are your toughest critic. Don’t get discouraged if you don’t hit 

on something brilliant immediately. Let the process work and revisit it until you’ve 

evolved your symbol into something you know fits for you. Remember your dreams and 

save your doodles to look at later: Your unconscious is always at work and more in touch 

with your feelings than your intellect is. 
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Shapes Exercise 3: Deconstruct a Corporate Logo 

Level: Moderate

This additional exercise blends the patterns and shapes explored in Chapters 12 through 21, 

and helps you to develop critical thinking skills. It also assists you in identifying and expand-

ing the symbolic communication contained within corporate branding communications to 

reinforce your own communication skills. My first book, Decoding Design: Understanding and 

Using Symbols in Visual Communication, has several examples of deconstructed corporate lo-

gos based in the patterning and shape used in the design and how they can be quite telling 

as to the actual intention of the corporation. 

1.	 Choose a logo that you have strong feelings for (pro or con), or feel is a powerful design. 

2.	 Using what you’ve learned from the chapters on patterns and shapes, begin by break-

ing down the components in the logo (general shape/s, pattern/s, colors, intent of the 

company, mission statement, actual press, and so on).

3.	 Make notes about the patterns and/or shapes used in the company logo to describe 

the organization and fully deconstruct how the shapes, patterns, and other information 

contained within the design effectively support the message or brand. 

4.	 If you see inconsistencies between the design and the message, deconstruct why they 

don’t work. Take these elements and redesign them to more appropriately reflect 

the company.
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Chapter 22 Exercise: Color Your World

1.	 Begin to explore the colors that are most appealing to you. Attraction implies a condu-

cive connection between things, including you and your choices. 

Hint: You can reference your mandala from the Chapter 6 exercise on symmetry. Select 

the colors that really worked for you in this exercise; ignore the ones that didn’t.

2.	 Create a palette in Illustrator or Photoshop. You can use the software-supplied color 

swatch libraries or your mandala, or do a search on the Internet to find various palettes 

that you like. If you choose color selections outside of a standard graphic design color 

tool such as Pantone, find the closest equivalent in match inks applicable to printing 

in your software program once you’ve created your color palette in your software pro-

gram. For example, in Illustrator these palettes are located under the Window menu: 

Window > Swatch Libraries > Pantone Solid Coated or Pantone Solid Matte.

3.	 Expand your preferred palette to include the associated saturations and values of the 

hues you’ve selected. 

4.	 Now expand your basic hue palette into its complimentary colors. 

Hint: Find an extensive color wheel on the Internet and look for colors that come as close 

as possible to your hues and reference their opposite hues on the wheel. You may need to 

tweak them a bit to find the best contrast.

This color chart will be a reference for your personal brand. 
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Chapter 23 Exercise: Presentation Prep

Bring together your various logo concepts that you’ve developed over the duration of this video 

series with their associated patterns, shapes, colors, and typography as a presentation for your 

own potential identity. Use this as an opportunity to get valuable feedback on which logo de-

signs are the most effective to represent your identity. 

Presentation Prep 1: The Digital Presentation

1.	 Select your most viable potential concepts to represent your own identity. Limit your-

self to three to five choices. If you haven’t refined your best contenders into a finished 

enough state to present, do that now. 

2.	 Create a digital multi-page presentation (one logo design per page) in InDesign or 

Keynote. Include a color and black and white version of the design, side by side. This 

will help you to identify the strongest designs from the weakest. Remember that strip-

ping your logo to its essence is the best way to determine if the logo has the flexibility it 

needs to work in any environment. 

3.	 Tweak the presentation so that the images are consistently located from page to page 

and have a good balance of air to filled space, and so that nothing is crowded or looks 

“off.” Other than the logotype—if you’re using one—and the page numbering, there 

should be no words (explanations, for example) on the pages. The most effective pre-

sentations are neutral, and consistency helps to achieve this. 

4.	 Export your presentation as a PDF document and send it to people whose opinions you 

respect and you know will provide valuable feedback. A good sample would be feed-

back from at least six recipients. Be sure to set up a cover page just as you would for 

a client with a description of what they’re receiving; when you would like to get com-

ments back (two to three days should be sufficient); and your contact information for 

their response (you won’t be branding this document with your identity yet). This is a 

blind sampling, much like a focus group, so in this case you will not be directing the pre-

sentation process. You want responses that are unencumbered by your opinion. Thank 

your recipients for their time and valuable feedback.
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5.	 Review the feedback from your sample group. Is there an overwhelming winner? (If so, 

you most likely already knew that.) Are there two or three that are very close in prefer-

ence? If so, can you possibly combine/eliminate aspects of the preferred designs to more 

accurately/beautifully/efficiently convey your work? You want to simply but substantially 

pack the most relevant information into the design. 

6.	 Complete your logo from the most viable feedback. 

Hint: If your design was significantly changed since receiving feedback, you may want to 

go into a Round 2 presentation. 

7.	 Once your design has been completed, host a dinner or take your respondents out for 

drinks and appetizers as a thank-you. Unveil your new logo at this event. Acknowledge 

their time and effort (but don’t forget to privately acknowledge yourself for complet-

ing this process. It’s not easy to put yourself out there as someone who offers value via 

their work!).

Hint: This is an excellent opportunity to create a giveaway as a thank-you (even if it’s 

just your new business card, which may help to inspire referrals) and get a jumpstart on 

your brand. 

Presentation Prep 2: The Hardcopy Presentation

This procedure is the same for Step 1 and Step 3 (no page numbers for Step 3); Step 2 will 

probably have printouts generated from Illustrator. 

1.	 Follow the same steps as for Step 1, above.

2.	 Follow the same steps as for Step 2, above, but you will probably generate printouts 

from Illustrator.

3.	 Follow the same steps as for Step 3, above, but don’t include page numbers.

4.	 Find a good viewing size for your presentation that all of your various logos will accom-

modate, and determine a complementary board size and color. Mount your presenta-

tion, one logo per board in both color and black-and-white versions (you can also show 

each logo on separate boards, but make sure they are in sequence with their color/

black-and-white counterpart).
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Hint: You can set up both the color and black-and-white versions of each design on a sin-

gle document and trim them apart after printing. Remember to leave enough air around 

all sides so that the design is not crowded by edges. I recommend orienting the color 

and black-and-white versions of the design at opposite ends of the page, with enough 

air in between, which allows you to only trim two sides of each design. Experiment with 

page and design sizes and orientations to get a good visual “fit” for the trim. 

Hint: Use a neutral-colored mounting board so as not to conflict or distract from the 

color selections in the various logo options you’re presenting. I’ve always used a heavy-

weight Crescent board in a medium gray color for in-person presentations, but many 

designers use a simple black Railroad board. Railroad board now comes in very light 

weights; be sure to choose one that is substantial if you go this route. You don’t want 

your presentation to fail in its execution and detract from the quality of the work. Do 

some measuring between the two logos that will be shown per board and the parent 

board size. This will take some back and forth to get the most use out of the board, 

while displaying the logos at their most optimal size. Art supply stores typically carry a 

wide variety of mounting board and can trim it down cleanly to your specified size. 

5.	 You only need to create one hardcopy presentation of the various logo designs. Present 

it to your select sample group (you don’t want a lot of cross talk or opinions influencing 

the honest response of others). They’re dedicating time and energy to your endeavor, 

so be respectful of their time and accommodate their schedule. It takes some effort on 

your part, but will be worth the feedback to help determine the best design. Thank your 

recipients for their time and valuable feedback.

Downside: It’s much harder to cover emotion in person than online, but you need to keep 

a poker face when presenting your work, particularly when you’re sharing a logo meant to 

represent you. Neutrality will yield honest feedback and help lead you to the most viable 

selection.

Upside: Presentations delivered in person offer the benefit of getting immediate gut 

reactions to your logos. Frame your questions appropriately and be sure to get complete 

information. For example, if a responder says, “I don’t like this one,” find out why he or she 

doesn’t like it. 

Steps 6 and 7 remain the same as above. 
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Chapter 24 Exercise: Finalizing the Artwork

This is the last step before implementing the logo, so make sure you have clean artwork! You will 

do a structural review in black and white first. 

1.	 Bring your nearly complete logo into Illustrator as a black and white. 

2.	 Toggle between viewing your work in outline and in normal view using Command-Y. 

This command allows you to see any points that are invisible in normal viewing mode 

(for example, beginning but not finishing a line of text will create an unused point). Find 

any extra points you may have inadvertently created and eliminate them. 

3.	 Also review the number of points you have in your Bezier curves. If the curves are lumpy 

or not pleasing, you probably have more points than you need. If this is the case you 

need to create a copy of the original logo for reference while you tweak the lines using 

either of these procedures: 

■■ Create a copy of your logo (Command-C) and place it directly below the original 

(Command-F) on a second layer, or

■■ Create a copy of your logo (Command-C) and place it directly below the original 

(Command-F), turn it into guides (Command-5) and then lock them (Option + Com-

mand + ;)

To check your work and see how it looks, you can also toggle between viewing layers by 

turning the eyeball off and on, or by hiding guides (Command-;).

Hint: In the event things go wrong (for example, you copy over the original when 

you didn’t mean to), it’s a good idea to always reserve a copy of the original when 

correcting work.

4.	 Once everything looks good to you, review the logo again. This time look at it upside 

down, reflected, and in any other orientation you choose to help see any outstanding 

errors you may not notice when it’s in its correct orientation. Correct if necessary.

5.	 Review your color. Check your palette in spot and CYMK color versions for printing. Make 

sure none of your CYMK percentages are in decimal points. If so, round to the lowest/

highest number. 

Hint: Print out test hardcopies of the logo in color. While desktop printers do not match a 

printing press, they often give you a more accurate assessment of color than a monitor can.
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Chapter 25 Exercise: Create Your Own Identity Guidelines Brief

Using your logo and any extensions you have designed, create an identity guidelines brief to get 

an idea of how the process works and its usefulness to your clients. 

1.	 Using your completed logo, create an identity guidelines brief (a single page document). 

You can create this in Illustrator or in InDesign.

2.	 Bring your logo into the software program of choice. Define color palettes in RGB and 

CYMK formats (and match colors, if you used them), and break down any uses of the 

logo applied to collateral such as business cards. Include point size, typeface, line- and 

letter-spacing, and distances between elements. You can also get into detail such as the 

exact spacing between the logo and logotype in various orientations.

3.	 Include any optional orientations in which the logo might be used, such as in vertical 

or horizontal formats, and define instances when the logotype and/or logo might be 

used separately. 

Hint: Watch the videos on creating identity briefs and extensive standards to get an idea of 

what kind of information you might want to include in your guidelines. 
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Chapter 26 Exercise: Begin Your Own Branding Process

Experimenting on yourself is a tenet of learning to become a good designer. You can afford to 

make mistakes here. It is both easier (you know yourself better than anyone else does) and harder 

(you are your own worst critic) than branding a client. In this branding exercise, you’ll begin the 

process by trying out expansions of your logo to fit and express who you are as a designer.

1.	 Make a list of the top three things you want to use to describe yourself and/or your ser-

vices. Where do you excel? Where do you want to excel?

2.	 What can you create beyond a standard business card to bring more dimension to who 

you are and/or how your services are different than other designers? I did this very sim-

ply with my business card by adding die cut square and round corners to suggest both 

strategic and creative thinking. Think beyond the 2D design of the piece and how it 

might be ramped up with a simple technique that more fully describes your work. 

Hint: Describing your business might also be in the name you choose if you don’t use 

your own name. Do you have a particular talent that is unique to you, for example, as an 

illustrator? Find a way to expand on this to set your brand apart from the others. 

3.	 Experiment! Try things that feel right or capture the objectives you want to achieve. Are 

you a humorous person? There is no need to hide that! Do you want corporate work? 

Be sure that every aspect of your image presentation fits your message and intent. Your 

portfolio will expand on your brand to describe your work in detail. 

It’s OK for your brand to change over the years as you develop as a designer. My brand has 

changed four times, or about once a decade. Each time I’ve changed it, it was because my 

experience demanded I revisit how I present my image to the world. 
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Chapter 27 Exercise: Copyright Your Work

It’s good practice to copyright your original work. This helps tie your name to your design and 

ensures your rights against plagiarism.

1.	 Select a piece of your work that you think would merit a copyright registration. This can 

be anything original such as a logo or illustration. Remember that letterforms and sym-

bols are not copyrightable unless they have been modified creatively and significantly. 

2.	 Go to the online Electronic Copyright Office website (https://eco.copyright.gov) and reg-

ister your new User ID and Password.

3.	 Go through the registration process to familiarize yourself with it. This will cost you 

a small amount ($35 per registration at the time this was written). If your design is 

accepted for registration, congratulations! This confirms it is an original piece of work. 

If not, review the Copyright Office’s reason/s for not accepting it. If you disagree, you 

may request a review with your reasons why you believe it is eligible for registration. 

You will need to pay the registration fee again for a review. 

4.	 Do this for all of your work you feel is original enough to receive a registration, whether 

or not you sell or grant full rights to it. This ensures that the work is always tied to your 

name and gives you legal recourse if it is ever plagiarized. 



Learn By Video
Design Fundamentals: Designing Effective Logos with Maggie Macnab

Chapter 27 Exercise: Create Your Own Business Papers

Apply your logo and identity extensions into a client proposal/agreement and invoice. 

Using InDesign or other page layout program, style your invoice and proposal with your 

identity. This includes your logo, color palette, and any additional elements you may have 

designed that would be pertinent in this use. 

The styling of the typography is critical. These are business documents; ease of use and 

legibility are the priority. They should be styled with your identity in mind, but be attentive 

to the fact that the proposal is a legal document, and the invoice a financial one. Restraint 

is more important than trying to demonstrate design skills (and restraint is a crucial design 

skill!). Always think of the recipient and how the design is being used. 

Included in the exercise folder for this video is the general terms language needed for a de-

sign project agreement. Please review the overview of the invoice and front of the proposal, 

and the recommended resources in the videos. Modify the language to suit your particu-

lar needs, and don’t forget to add sign-off areas for you and your client to acknowledge 

your mutual agreement.
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GENERAL AGREEMENT TERMS FOR A DESIGN PROJECT

Based on the Graphic Artist Guild’s standard contracts and the Joint Ethics Committee Code of 

Fair Practice for the Graphic Communication Industry

1. Fees

Design and production will be billed at flat fee (or hourly) rate stated on front of proposal. 

This includes the creation of final artwork/production and time consulting with Client and 

any others to facilitate completion of the assignment.

This agreement is based on a reasonable time schedule. In cases when the schedule changes 

requiring the work to be done on a RUSH basis, Designer reserves the right to revise the esti-

mate to cover overtime expenses, which will be billed at the additional charge of $X/hour.

The stage and price breakdowns stated in this document and any other estimates relat-

ing to this assignment will hold for 60 days, after which time they may be revised by the 

Designer.

2. Fee Schedule

A 1/3 retainer fee down is required to initiate the project, 1/3 is due upon design accep-

tance, and the balance is due upon design completion. Fees do not include any applicable 

taxes or out of pocket expenses (approved prior to purchase). 

3. Expenses

Client will reimburse Designer for all out-of-pocket expenses arising from the assignment. 

This includes any applicable unusual or excessive supplies, outside services, delivery charg-

es, sales tax, shipping, postage, toll telephone charges, facsimiles, and any film production 

and printing related costs. There will be no more than a X% mark-up on these expenses. 

Invoices will be supplied to client upon request. Mileage will be charged at the current rate 

of $.X per mile for trips beyond normal consultation with client and support services. 

4. Cancellation

If the assignment is canceled during Phase I or II, ownership of all rights and original art-

work is retained by Designer. A minimum cancellation fee of the first phase deposit shall 

be retained by Designer to compensate for work completed thus far, as well as any hourly 

charges (at the rate of $X/hour) for work extending beyond Phase I, if applicable.  
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5. Credit

Designer retains the right to use any artwork or finished product for self-promotional pur-

poses in print or digital format. 

6. Changes

Changes made at the design or production stage of the assignment will incur additional 

costs based on the current hourly rate. Development of Phase I and II includes two rounds 

of revisions determined in consultation with client. 

If there are other significant changes to either the design or production stages that were 

not in the original assignment, a modification of this agreement will be written. Client 

agrees to pay any fees for changes that were orally authorized in order to proceed promptly 

with the assignment.

No additional payment will be made for changes required to conform to the original assign-

ment description. Client will offer Designer the first opportunity to make any changes.

7. Ownership

Designer transfers limited rights to Client to use in commerce to promote Client provided 

all fees are paid in full. Full rights are not extended for franchising, transferring, or selling 

the design to another organization, or expanding the design into national or international 

branch offices. Under these circumstances, a new agreement with compensation commen-

surate for use will be negotiated. 

All preliminary artwork from this assignment will remain the property of the Designer, along 

with any design ideas not used in the assignment.

8. Legal Matters

Client is responsible for all claims made, all trademarks, copyrighted materials, and 

clearances. 

Designer agrees to protect any property or materials belonging to the Client and to guard 

against any loss of these materials. In the absence of gross negligence, Designer is not 

responsible for loss, damage, or unauthorized use of property by others such as printers, 

photographers, or media. 
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Should Designer sustain any losses as result of a claim, suit, or proceeding brought against 

the Client from the publication of material approved and authorized to be produced, Client 

will indemnify Designer for those losses. 

Should Designer need to retain an arbitrator or attorney to settle any disputes arising from 

this assignment (including the collection of any invoices), all fees and court costs that are 

reasonable and necessary, as well as any interest charges incurred, will be paid by the Client.

At the bottom of your agreement, be sure to set up blank areas for signatures and dates for both 

parties (client and designer).
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Chapter 28 Exercise: Put Your Work Out There!

Putting your work into the world is the culminating exercise of this series. It is also the hardest. 

As you have come to realize by now, Designing Effective Logos is about so much more than just 

design. The true litmus test is getting the work. But to get it, you must put yourself out there. This 

last section of videos is designed to get you in front of your future clients so you can get the work. 

1.	 Live and in person! Develop and design a hardcopy portfolio. Include your best work, 

printed out on a high-quality printer, trimmed concisely, and mounted to look its best. 

You can go the traditional route of a portfolio flip book or you can design something 

much more elaborate. 

2.	 Get a web presence! From simple to sublime, you can get your work up and start work-

ing the business end of design. There are multiple platforms for web portfolios, from 

free to pricey, and from simple to complex. You don’t have to know HTML to use most of 

these platforms and their tools; you just need patience and some good work to display. 

Research the platforms, ask designers who use these platforms what they do and don’t 

like about their chosen method of delivery, and try one out. You can start simple and 

evolve as your business does. 

3.	 Pick a cause! Do you need more work for you portfolio? Whether you’re an animal 

advocate, a gardening proponent, politically active, or just want to help out your com-

munity, choose a cause and offer pro bono services to help an organization you care 

about—and build your portfolio at the same time. 

4.	 Uniquely you! Design a self-promotional piece. It can be a standard email announce-

ment or mailed postcard, but be sure to brand it to uniquely convey you and your work. 

Or push it a bit and design something completely unexpected. You can apply your logo 

and brand to just about anything you can think of. Don’t stop at mugs: Consider a laser-

cut poster (or product), a chocolate bar design, a T-shirt, or even a street art campaign. 

5.	 Finally, share the love! Please join the Designing Effective Logos Facebook group. 

We want you, your work, and your comments! Everyone’s work improves in a profes-

sional forum that is supportive, offers resources, and provides constructive feedback. 

The entire purpose of the Designing Effective Logos series is to support you in doing what 

you love to do so that you can provide the world with more beautiful design. You’ve 

watched this video because you’re committed to doing your best as a logo designer. 

Now let the design community support you in making that happen. Questions, critiques, 

advice…whatever your interest or need, please join and ask!
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